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1. The synthetic dataset 
Consider the following set of dummy data. It is shown here in an Excel spreadsheet format, but could equally be in a 
textfile (.TXT; .CSV, etc) or in any other data table in almost any type of application (e.g. ArcGIS; MapInfo; Microsoft 
Access; Micromine; Oracle;….). Only the first 10 rows of data are shown.  

In this dataset, there are some primary orientation data 
in columns 2 & 3 and some associated data in columns 5 
& 6. All other columns contain data we are not 
interested in.  

The primary orientation data might represent planes, or 
lines, or we might just be interested in plotting the 
directions as rose diagrams.  

In this instance, the Conventions I have used are dip and 
dip direction for planes (or plunge and plunge direction 
for lines). Your data conventions might be different and 
can be set in the Conventions Tab after you open the data.  

2. Open the data for plotting  
If the data already exist in a text file, then open it using the File.. Open 
menu, or the Open file button. This action will open the File Formatting 
dialog. 

More commonly, it is easier to just copy the data block from the source 
table and paste it into GEOrient. To do this: 

1) Select and copy the data block in the spreadsheet 
2) Open GEOrient and select Blank Plot (either from the icon button or 

from the File menu). The plot will open initially as a blank stereonet 
circle, even if you only want to plot the directions as a rose diagram. 

3) Select Paste External Data, either from the Edit menu or by hovering 
over the blank plot and pressing the right mouse button.  

Initially the File Formatting dialog will open on the first tab as 
in the figure above, but to ensure that we indicate the correct 
structure of our data, open the DataFormats tab.  

1. Check that the data columns are displayed separately. If 
they aren't in separately numbered columns, then you 
may need to change the Delimiter character. Since I have 
copied these data from an Excel spreadsheet they are in 
Tab-delimited form. But if your data is from a CSV file, for 
example, you would need to indicate the delimiter as a 
comma. 

2. Check the type of Primary data. Initially here, I will treat 
the data as Planes in the first example. 

3. Now indicate which columns the different parts of your data are in. The default will be to show columns 1 
and 2 as the dip and direction columns, but here I need to set the dip in column 2 and the direction in 
column 3. [These column numbers can be set manually but can also be quickly set by first clicking on the 
Column dropdown combo and then by clicking on the column heading in the data table below]. 

4. Check the box indicating that the first column contains the column headings. It doesn't matter whether or 
not you do this. As that headings row is non-data, GEOrient will not plot it anyway. 
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If we are going to use the alphanumeric data in the Bed lith column or the numeric data in the Bed thickness 
column then we need to indicate these columns as Appended Data. Open the Appended Data tab.  

1. Check the numeric value checkbox and give a name to 
the numeric value if you wish and indicate which 
column it is in (here it is 6).  

2. Do the same for the Lith column. Here that data is in 
column 5 

 

 

 

 

We now have fully described the structure of our data so return to 
the first 'Plot as:' tab. In this instance we have indicated that our 
data are planes, so we will plot them as planes using the button 
with the strike/dip symbol. [Note that it is quite possible to choose 
to plot the data as lines. In this instance the dip and dip direction 
will be plotted as lines].  

 

The data will now display in the stereo circle as points. These will be 
poles if you have chosen to plot the data as planes or will be lines if you 
have chosen either the Line button or the Polar Line button. Lines are 
for axial data, where the sense of direction of the line is immaterial (for 
example, fold axes). Polar Lines are where the sense of the line is 
important (such as current directions, or sense of slip vectors in fault 
data).  

3. Changing the type of plot  
We can choose to display these plane data as different types of plot 
display using the buttons in the toolbar. It is at this point that I would 
select the Rose Diagram button to plot circular histograms of the 
direction data. I will describe that in another section. 

4. Stereonet plots 
I most commonly choose to show 
plots as contoured gridded density 
plots (using the button with the 
red arrow). When you first plot 
the data with this button it will 
show a sparse density grid. To get 
the type of display shown here I 
increase the grid density to a high 
number using the textbox with the 
blue arrow and its associated 
slider bar.  
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5. Analysing the stereonet data 
The bedding data here show a great circle spread of poles, which 
would indicate a cylindrical fold. To quantify that we can overlay a 
calculated great circle, a calculated beta axis, or our own manual 
great circle overlays.  

1) Use the girdle button (red circle) to open the girdles panel. 
2) Check the Calc.Girdle and Beta axis checkboxes to add the 

calculated features. 

The beta axis is the calculated orientation of the fold axis, which here 
plunges shallowly to the southeast (9-132). The girdle contains two 
distinct point maxima of unequal size. These maxima would be the 
orientation of the fold limbs, with the larger maxima being a longer 
limb. Thus, we have an inclined asymmetric fold plunging shallowly southeast. The longer limb dips shallowly to 
the southwest and the shorter limb steeply to the northeast. That is, these folds verge to the northeast. 

I'd like to add manual great circles to represent the orientation of the fold limbs and an estimate of the 
orientation of the axial plane, which will pass through the fold axis (the beta) and lie a little closer to the longer 
limb than the shorter limb. I'd like these manual great circles to have a different style to the default dashed lines, 
so I change these in the Preferences dialog (see section below).  

6. Manually inserting great circles 
User-defined great circle girdles can be plotted either by manually 
filling in the orientation text boxes or by pointing and clicking. It is 
generally easier to point and click.  

1) Double-click in one of the Girdle textboxes (e.g Girdle 2 - blue 
circle); hold down the shift key and using the right mouse 
button click in the centre of the larger central point maximum 
(blue arrow). This will insert a great circle whose pole is the 
point you just clicked on. [Read the help file for the various 
point and click options, or just experiment]. 

2) Do the same for the smaller southern maximum (red arrow). 
Double click on the Girdle 3 textbox, and Shift-Right-click on 
the centre of the maximum (red arrow).  

3) We can only estimate the orientation of the axial plane, but we add a third great circle by Shift-Right-
clicking at an appropriate point on the calculated best-fit girdle (green arrow) such that it adds a great 
circle that lies somewhat closer in orientation to the shallow limb than to the steep limb (green).  

7. Annotations: adding user-defined symbols or beta axes 
If you wish to ignore the calculated girdles and the beta axis, then 
uncheck those checkboxes and add them manually. To use your own 
beta axis, you need to add it as an annotation. Annotations are point 
symbols that are added in their own layer.  

· Open the annotation tab on the plot itself. New points are added 
by using the Alt key with either the left or right mouse button. 
Be careful to make sure that you have the Annotation tab 
selected as else you will be adding points to the dataset itself. 
When selected, the annotation tab has a red line beneath the 
word 'Annotation'. Here I have added a cross, perhaps to represent the orientation of a horizontal  
trench from which the data were derived.  
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8. Changing symbols, line styles or colours: Preferences dialog 
In the figures above, I have changed the weight and colour of lines 
and symbols. To do this I have changed their values in the 
Preferences dialog. To access this dialog, hover over the plot, right 
click the mouse button and select Preferences… from the drop-down 
menu. The Preferences option is also available from the Edit menu.   

To change lines on the plot: 

· Open the Lines tab in the preferences dialog and change the 
style, colour, and weight of the girdles you wish to modify. 
Here I will set girdle 2, 3, and 4 to blue, red, green solid lines 
with a thickness of 2 pixels. Click inside each of the 
textboxes in turn, then select the solid line style, then adjust 
the Width slider to the second tickmark, then click on the 
desired colour. Then repeat for any other lines you wish to 
change. Press OK when done.  

To change symbols on the plot: 

· On the first Symbols tab, follow a similar procedure to 
change the symbols you want to use. Note that the symbol 
labelled Beta axis refers to the calculated beta axis. Here I 
have added a second, differently coloured beta axis as a 
Right-click annotation symbol so that I can use it as a 
manually-added beta if I don't agree with the location of the 
calculated axis. [Note that the beta symbol character does 
not display on many computers. It is the symbol in the lower 
right cell of the set of available symbols (circled in red).  

· In this same Symbols tab, I have reset the colours of some of the point symbols that I want to use. Other 
tabs in this Preferences dialog allow a large amount of flexibility in how your plots look. 

In most instances the stereonet at this point is all you want. But we have Appended data that we can use to 
delve deeper plotting either simple classified stereonets, or 
numeric stereonets. The use of these options is described more 
fully in the Help dialog. 

9. Classified Stereonet Plots 
Classified stereonet plots allow you to modify the plots by 
including the Appended data. In its simplest form we will simply 
colour the plotted poles by the Lithology column, or even by 
ranges in the numeric data.   

1) Select the Data Classification button in the toolbar (or the 
Show Data Classification dialog item under the View 
menu). 

2) Set the number of base classes you want to use. GEorient 
will attempt to prepopulate the textboxes. Here I have set 
4 base classes for the Appended alphanumeric data in the 
Lith column. I have set 5 base classes for the numeric data 
and manually reset the data ranges for each. 

3) Click the Classification that you want. Here I have selected 
'Classify by lithology'. Press GO.  
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If I selected' Classify by thickness' I would be presented with a dialog extension that allows me to select 
'Classified data points'. This option will treat the numeric ranges as coloured points in the same way as the 
lithology above.  

 

10. Numeric Stereonet Plots 
When I choose 'Classify by thickness', which is a numeric value, I am 
presented with an expanded Classification dialog that provides me 
with options to plot or contour the actual numeric data. In some 
situations, this provides a powerful tool, such as when the orientation 
of veins also includes their thickness and assay values.  

Numeric Stereonet plots are a variant of Gridded Density plots. At 
each grid point, the values associated with any vectors (lines or 
normals) that lie within the counting cone are plotted.  

1) Choose whether the grid values are to be the 'Cumulative' 
sum of all vectors lying within the counting cone, or the 
'Mean' value of those vectors 

2) Reset the Numeric ranges as these will be different for Means 
or Cumulative totals. In this instance, the Cumulative values 
are chosen, and the range of values is 1-109. 

3) Select how to display the data. In the first plot (right) I have 
chosen 'Gridded values'. The density of the grid is still set from 
the previous stereonet plot.  

In this instance, the cumulative thickness of the beds 
at each grid point is not particularly surprising. The 
point maxima in the plot coincide with the point 
maxima in the frequency plot, so the maximum 
cumulative thickness simply corresponds to the 
maximum frequency. 
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4) But it is a little more meaningful, in this instance, to 
look at the mean thickness by orientation. In this 
plot I have chosen 'Mean thickness', and have reset 
the ranges from 0-19 accordingly.  

In this instance, there is a clear relationship between the 
Mean thickness of the beds and the position in the fold. The 
yellow maximum corresponds to the hinge area of the 
folds. [This would be a clear indication of non-parallel folds 
and a component of flattening]. 

 

 

11. Rose Plots 
Any stereoplot can be shown as a Rose Plot of the directions by selecting 
the Rose button in the toolbar (red circle). Here we have indicated that our 
data were planes when we loaded them, so the Rose plot shows a histogram 
of the strikes, not a terribly useful way to look at this 3D data.  

In order to demonstrate rose plots, I will reload the same data, but this time 
I will indicate that they are directions only, and will plot them as Polar Lines 
(i.e as vectors). The Appended data will remain the same. 

The first time you plot these data they will be displayed 
around the edges of a stereonet circle. Select the Rose plot 
button to display them as a rose diagram. The initial Rose 
plot will be a simple Frequency-Azimuth plot. An additional 
Rose Diagram dialog will be displayed that allows you to 
reset the rose parameters and style, and to select other 
plotting options.  

Because we have additional appended numeric data (the 
bedding thickness), this dialog will display additional 
options for plotting various thickness parameters. Below I have 
chosen (red circle) to overlay the Mean thickness plot over the 
Frequency azimuth plot.  
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12. Classified Rose Plots 
Any data that has either appended associated numeric or alphanumeric (text) data can be shown as classified rose 
plots. That is, a plot in which the rose sectors are equivalent to stacked histograms. 

3) At the bottom of the Rose Plot dialog is a section labelled Classified Rose. It will initially be set at No 
Classification. But by selecting either the numeric data button (thickness in this example) or the 
alphanumeric data button (lithology in this example) and pressing the GO button, the data will display as a 
Classified Rose. Here, I have a Frequency-azimuth plot classified first by thickness, then by lithology. In this 
instance of synthetic bedding data, this type of plot does not tell you much. But, for example, if the 
directions were strikes of veins, and the alphanumeric data were vein types, then Classified Rose plots are 
very useful.  
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